
                

 

FastStats Discoverer 
Everything you wanted to know about… 

Wizards & Virtual Variables 

FastStats Discoverer 
Everything you wanted to know about… 

FastStats Geo (v1.1) 



                    
 

Everything you wanted to know about… 

FastStats Geo 

Document Version: 1.1 
 
Software Version:  Q1 2015 
 
Data Version: Training 1 (Holidays) 
 
MapPoint Version: 2004 

 
 
 
 
 
 
 
 
 

      Apteco Limited 
          Tink-a-Tank House 
          21 Jury Street 
          Warwick 
          CV34 4EH 
 

      +44(0) 1926 407565 

      +44(0) 1926 407545 

       www.apteco.com 
 

  

FastStats Discoverer 
Everything you wanted to know about… 

FastStats Geo (v1.1) 



                    
 

Contents 
 
Introduction .............................................................................................. 1 
How to Login ............................................................................................ 3 
Map Options ............................................................................................. 4 
Microsoft MapPoint ................................................................................... 5 

Shaded Map ......................................................................................... 5 
Shaded Map - The Layer Tab ............................................................... 6 
Shaded Map – Viewing the Map ........................................................... 7 
Shaded Map – Viewing the Results ...................................................... 8 
Shaded Map – Using a Segment Variable ............................................ 9 
Shaded Map – Adding Statistics ......................................................... 10 
Plot Map ............................................................................................. 11 
Plot Map - The Layer Tab ................................................................... 12 
Plot Map – Viewing the Map ............................................................... 13 
Plot Map – Viewing the Results........................................................... 13 
Plot Map – Create Drivetime Zone ...................................................... 15 
Multiple Layered Maps ........................................................................ 16 
Searching the Map .............................................................................. 17 
Selecting from the Map ....................................................................... 18 

Map Wizards .......................................................................................... 19 
Drive Zone Wizard .............................................................................. 20 
Location Geocoder.............................................................................. 22 
Point to Point Wizard .......................................................................... 24 
Territories Wizard................................................................................ 26 

Bing Maps .............................................................................................. 29 
Shaded Map ....................................................................................... 29 
Shaded Map - The Layer Tab ............................................................. 30 
Shaded Map – Viewing the Map ......................................................... 30 
Shaded Map – Viewing the Results .................................................... 32 
Shaded Map – Using a Segment Variable .......................................... 33 
Shaded Map – Adding Statistics ......................................................... 34 
Plot Map ............................................................................................. 35 
Plot Map – Viewing the Map ............................................................... 36 
Plot Map – Viewing the Results........................................................... 36 
Plot Map – Create Drivetime Zone ...................................................... 38 
Multiple Layered Maps ........................................................................ 39 

 
 

Searching the Map .............................................................................. 40 
Selecting from the Map ....................................................................... 41 

Appendix 1 – Further Information ........................................................... 42 
FastStats Geo Module ........................................................................ 42 
Boundary Files .................................................................................... 42 
Microsoft MapPoint ............................................................................. 42 
Bing Maps ........................................................................................... 42 
OpenStreetMap .................................................................................. 42 

 



 
FastStats Discoverer – FastStats Geo                        User Document 

FastStatsTM                   Apteco Ltd © 2000 – 2015             1 

 

Introduction 
 
Understanding the geographical distribution of your customers and 
prospects can increase insight of your marketplace, highlight areas of 
untapped potential and facilitate campaign planning and execution.  
The FastStats Geo module is an integration with Microsoft MapPoint, 
Microsoft Bing Maps or OpenStreetMap, that allows you to visualise 
the spatial distribution of your data and export targeted selections for 
immediate use in your marketing campaigns. See Appendix 1 – 
Further Information. 
 
Microsoft MapPoint 
 
Users of this module will need Microsoft MapPoint installed on their 
machines.  Microsoft MapPoint is not included with the FastStats Geo 
licence, but is available from many retailers with either European or 
North American maps.  Please check the Microsoft website for details 
of countries covered. 
 
Microsoft Bing Maps 
 
Online mapping using Bing & OpenStreetMap provides street level 
mapping for all regions in the world.  Users will need to subscribe to 
the online Bing Maps web service through Apteco and ensure they 
have the relevant boundary files.  OpenStreetMap is a free service.  
The mapping wizards are not available with the online module. 
 

 N.B.  This document looks at the main relationship between 
FastStats and the Mapping tools.  For specific functionality of the 
mapping software refer to the Microsoft online help. 
 

 N.B.  The examples in this document are for illustrative purposes 
only.  You will not be able to follow these exact examples in reality 
unless you have the relevant licenced software and access to the 
Holidays training system. 

  

 
                        Microsoft MapPoint 
 
 

 
            Microsoft Bing Maps 
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The Example Data 
 
The FastStats system that you will use for training is based on the 
1,156,553 customers of a holiday company and the 2,130,081 holidays 
that they have booked.  The variables consist of geodemographic 
attributes of the customer such as postcode, occupation etc. and 
bookings data including booking date, value, product etc.  Although 
this data might not exactly match your business sector, the general 
structure of customer records with potentially many transactional 
records is a common one within marketing data e.g. customers-orders, 
customers-accounts etc.  FastStats supports much more complex 
hierarchies, but all the core functions can be demonstrated with this 
data set. 
 
The data has been generated from a random data source, but is 
otherwise realistic, with most standard data types represented. 
 
The image opposite shows the table structure in the underlying 
Discoverer database which uses a One to Many relationship e.g. 
households could contain many people and people could book many 
holidays.  The table called Journeys relates to data that is used with 
the PeopleStage software.  See the last page of this manual for more 
details. 
 
 
 
 
 
 
 
 
 
 
 
 
 

  

 
 

 
 

 
 

 
   FastStats Discoverer Training Database Table Structure 

Households 

People 

Bookings Insurance Communications Journeys 
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How to Login 
 
You can start FastStats Discoverer by: 

 Clicking on the FastStats Discoverer icon on your 
desktop, or 

 
 Navigating via  

 

      Start → All Programs → FastStats → FastStats Discoverer 

 
In the top left hand corner of the screen you will see a Login window 
that gives you the opportunity to connect to a FastStats system.  
 

Enterprise Login 
 
Your organisation may hold your FastStats system on a server so that 
a number of Users can access it at the same time.  Your FastStats 
Administrator will be able to set you up with a Username and 
Password.  
 

Local Login 
 
If you have fewer Users you may find that the FastStats system is held 
on your PC.  In this instance you may need to navigate to the 
appropriate .xml file for your system through the Browse button.  If you 
are connecting to your system for the first time you will need to set up 
some standard links through the Create button. 
 
This document is based upon  the Training 1 system (Holidays) 
 

 Enter your details if appropriate and click the Login button 
 

 
 

  

 
                                  Enterprise Login Window 

 

 
                                  Local Login Window 
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Map Options 
 
If you have both MapPoint and Bing licences you can select the one 
you wish to use and the default settings you see, from the FastStats 
Discoverer Options window. 
 

 On the menu bar click on File → Tools → Options… 
 

 Under the Sections column select Map to see 3 further sub 
menus 
 

The screen shot opposite shows the Map region options set for 
Europe (United Kingdom) using MapPoint.  Other default settings such 
as map type, distance units, routing options can be made on the other 
sub menus. 
 

N.B. – If you are using an online mapping service you will need to 
select the option World from the World region drop down menu. 
 
 
 
 
To start using your mapping tool: 
 

 Open a selection window containing the records you wish to 
work with 

 
 Drag the Map tool from the Visualisation section of the 

Toolbox ribbon bar onto your selection window 
 

The following pages will start with examples using MapPoint. 
 

  

 
               FastStats Discoverer – Options Window 

 
 

 
                                           Toolbox Ribbon Bar – Map Option 
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Microsoft MapPoint 
 

Shaded Map 
 
A shaded map allows us to display records using particular 
geographical boundaries e.g. by Postal Area, Postal District or Postal 
Sector in the UK.  This gives us the opportunity to look at the 
distribution of our customers or prospects around the country. 
 
In the following example we will display a selection of people, who are 
managers that have made bookings to the US and display them on a 
shaded map by Postal Area. 
 

 Create a selection query that identifies Managers who have 
booked holidays to the United States 

 

 Drag and drop the  Map tool on top of the selection window 
 
The Map page has two tabs; the one entitled Map currently shows the 
default display region and will be where the final display will be shown.  
The second tab, entitled Layer 1 is where we define how the results 
will be displayed.  Multiple layers can be added to your map, which will 
be covered further on in this document. 
 

 Click on the Layer 1 tab 
 
An explanation of the options on this window is shown on the next 
page. For now we will just make the changes shown in the screen shot 
opposite i.e. drag on Postal Area as the Geographical Variable and 
change the layer title. 
 

 Click the Build button 
 

  

 
                                 The Map Tool – Map Tab 

 
 

 

 
                      Layer Tab – Shaded Map 
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Shaded Map - The Layer Tab 
 

 
Map Layer Title 
 

 
Enter the description to be shown on the layer tab and legend display 

 
Resolve Table & Filter 
 

 
Set the table level and any record filter here to determine the records shown e.g. People or Household figures 

 
Map Type 
 

 
Choose between the Shaded and Plot Map options 

 
Default Display Style 
 

 
When viewing the Map results select to show the Descriptions or Codes for items 

 
Geographic Variable 
 

 
Drag and drop here the geographical variable to determine how the data will be shown on the Map 

 
Segment Variable 
 

 
Allows you to segment the data by the selection variable used, displayed as pie, column charts etc. 

 
Statistics Panel 
 

 
This area displays all the statistics that have been added for possible display on the map 

 
Add Statistics… 
 

 
The statistics window allows you to define which statistics will be made available in the statistics panel 

 
Help… 
 

 
Click this link to open the FastStats Help files 

 
Display MapPoint Wizard for Next Build 
 

 
Displays the wizard each time the map is built so you can change the graph type and other options 
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Shaded Map – Viewing the Map 
 
Now that the results have been calculated and displayed, we can see 
the Map area has zoomed in on the UK.  Each Postal Area that 
contains records from our selection has been colour shaded.  The 
colour shading has defaulted to Quantiles of 8 ranges.  To change the 
shading settings: 
 

 Right click on the legend heading (Managers with US 
Bookings) and select Format Legend… 

 
Here you will find options to change the range type, number of ranges, 
range labels as well as the colours used on the display.  For more 
details use the Microsoft Help for MapPoint. 
 
To get a closer or different view on the Map: 
 

1. Use the zoom function to the right of the Find button on the 
tool bar to zoom in or out of the map 

2. Using the Select pointer, left drag across the area of the map 
you are interested in, then click within the shape drawn  

3. Move your mouse pointer to the edge of the map, a white 
arrow will appear and move the map in that direction when 
clicked 

4. Click and drag within the shape on the mini map in the top left 
area of the window to move around the map 

 
The screen shot opposite shows the map centred over Warwick, the 
home of FastStats. You may find the overlay of the road network 
distracting.  You can remove this by: 
 

 Click on the drop down arrow next to Road and Data Map and 
select Data Map 

 
You can now see the Postal Areas more clearly. 

  

 
                     A Shaded Map 

 

 
                      A Shaded Map – Zoom In View 
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Shaded Map – Viewing the Results 
 
Now that we have removed the road network we can see more clearly 
the Postal Areas with their letter codes being displayed e.g. CV for the 
Coventry Postal Area. 
 
The results of our underlying selection have been applied through the 
colour shading.  The legend, depending on the settings used may have 
a wide range of results associated with a particular colour. 
 
To find the actual result move the mouse pointer over the Postal Area 
of interest and the tooltip will display the count. 
 
 
 
To select results from our map we can use tools from the Drawing Tool 
bar.  In this example we will use the scribble tool to find an area of 
interest. 
 

 Click on the Scribble tool and drag the pencil icon onto the 
map. Click and hold the left mouse button to draw a joined up 
shape 

 
The white boxes on the line show it is active.  If they disappear click on 
the line again. 
 

 Right click within the shape and drag off the map to create a 
selection of your area 

 

N.B. – The line drawn on the map crosses several Postal Areas, 
so how does FastStats interpret your shape?  FastStats looks to see if 
your line encompasses the centre point (centroid) of a geographical 
variable and if it does it will include everyone in that area.  So for a 
more accurate result a more granular variable should be used e.g. 
Postal Sector. 
 

  
 

 
                    Shaded Map – Tooltip Count Display 

 
 

 
                    Shaded Map – Scribble Tool Selection 
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Shaded Map – Using a Segment Variable 
 
When using the shaded map option it is possible to display segmented 
data from a selector variable or selection query.  For example we may 
wish to display graphically the most important occupations of our 
customers by the Postal Area in which they live. 
 

 Using a blank selection drag on a Map tool and change the 
Layer 1 tab to reflect the options in the screen shot opposite 

 

 Click the Build button 
 

You will now be presented with MapPoint’s Data Mapping Wizard.  The 
Map Type step is displayed first.  Here you can click on the different 
map types to work out which one is most appropriate for the data we 
want to display. 
 

 Click on the Column Chart button and then click Next> 
 
The next step allows us to choose the categories of our segment 
variable we wish to display.  You can further divide the data variables 
we select by one of the items in the drop down menu.  The bottom 
panel will highlight Postcode Area as we have already selected this 
geographical variable on the Layer tab. 
 

 Tick director, manager and professional and then click 
Next> 

 
The next 2 steps allow you to change the legend title, the legend range 
and also the legend labels. 
 

 Click Finish to display the results as a series of column charts 
on each Postal Area 

 

N.B. – Moving the mouse pointer over a column chart will display 
the details in a tooltip. 

  
 

 
                              Layer Tab – Occupation as the Optional Segment Variable 
 

 

 
             MapPoint Options - Displaying a Segment Variable 
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Shaded Map – Adding Statistics 
 
As well as displaying values e.g. the number of People on a map, you 
can also generate and display a calculated statistic for those people 
being represented on the map. 
 
Let’s use the example of Top Occupations by Postal Areas which we 
used in the previous example.  We can now amend this example to 
optionally display the total profit each of those occupations (in the 
specific Postal Area) has contributed to our business. 
 

 Click on the Layer tab (Entitled Top Occupations by Postal 
Areas) 

 
 Click on the Add Statistics… button to display the Statistics 

window 
 

 Click on the radio button Specify other Table, Variable or 
Expression 
 

 We can now drag on the Profit variable and select the statistic 
we want to apply (in this example Sum) 
 

 Click OK 
 

 Within the Statistics panel change the Primary Statistic from 
People to Sum(Profit) 
 

 Click the Build button 
 
When we move the mouse pointer over a column chart, the tool tip that 
is displayed now shows the total profit figure per occupation for the 
Postal Area they live in. 
 
 
 

  

 
                         Statistics Window – Summing the Profit Value for People 

 
 

 
             Shaded Map View – Sum of Profit Statistic Display 
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Plot Map 
 
A plot map allows us to display records using a more precise 
geographical boundary e.g. by UK Postcode.  This gives us the 
opportunity to look at the location of smaller groups of customers or 
prospects around the country. 
 
In the following example we will display a selection of people, who live 
in the Coventry Postal Area and earn £70-80K or more. 
 

 Create a selection query that identifies the high earners in the 
Coventry Postal Area 

 

 Drag and drop the  Map tool on top of the selection window 
 

 Click on the Layer 1 tab 
 

 Complete the window as shown opposite 
 
An explanation of the options on this window for a Plot Map is shown 
on the next page.  
 

 Click the Build button 
 

  
 
 

 
    Layer Tab – Plot Map 
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Plot Map - The Layer Tab 
 

 
Map Layer Title 
 

 
Enter the description to be shown on the layer tab and legend display 

 
Resolve Table & Filter 
 

 
Set the table level and any record filter here to determine the records shown e.g. People or Household figures 

 
Map Type 
 

 
Choose between the Shaded and Plot Map options 

 
Default Display Style 
 

 
When viewing the Map results select to show the Descriptions or Codes for items 

 
Geographic Variable 
 

 
Drag and drop here the geographical variable to determine how the data will be shown on the Map 

 
Add Reference Number 
 

 
This allows a selection to be dragged off the map listing the URN 

 
Additional Variables 
 

 
Information for these variables can be accessed for records displayed on the map 

 
Display MapPoint Wizard for Next Build 
 

 
Displays the wizard each time the map is built so you can change the graph type and other options 
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Plot Map – Viewing the Map 
 
To get a closer or different view of the Map: 
 

1. Use the zoom function to the right of the Find button on the 
tool bar to zoom in or out of the map 

2. Using the Select pointer, left drag across the area of the map 
you are interested in, then click within the shape drawn  

3. Move your mouse pointer to the edge of the map, a white 
arrow will appear and move the map in that direction when 
clicked 

4. Click and drag within the shape on the mini map in the top left 
area of the window to move around the map 

 
The screen shot opposite shows the map centred over Coventry.  
 
 
 

Plot Map – Viewing the Results 
 
To select results from our map we can use tools from the Drawing Tool 
bar.  In this example we will use the scribble tool to find an area of 
interest. 
 

 Click on the Scribble tool and drag the pencil icon onto the 
map. Click and hold the left mouse button to draw a joined up 
shape that encompasses the pins you are interested in 

 
The white boxes on the line show it is active.  If they disappear click on 
the line again. 
 

 Right click within the shape and drag off the map to create a 
selection of your area 

 
 
 

  

 
            Plot Map – High Earners in Coventry Postal Area 

 
 

 
               Plot Map – Scribble Tool Selection 
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When we were setting the options on the Layer tab we added 3 
variables to the Additional Variables panel.  This will allow us to view 
this information for the records shown on the map. 
 

 Right click on a pin on the map 
 

 Select Show Information from the pop up menu 
 

If the pin represents a single record, a balloon will appear with the 
URN and the relevant variable information for that record. 
 
If the pin represents more than one record, a window will appear listing 
the postcode for each of those records. 
 

 
 

 
                Plot Map – Show Information 
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Plot Map – Create Drivetime Zone 
 
It is possible to use this function to find People who live within a 
determined area calculated upon the number of minutes it takes to 
drive from a given point. 
 

 Using the Plot Map from the last example, create a drive time 
zone of 20 minutes from the centre of Warwick 

 
 Type Warwick into the Find a Location box and click Find 

 
If necessary we can be more specific with our starting point by using a 
Postcode. 
 

 Highlight the appropriate location and click OK 
 

 Right click and select Create Drivetime Zone… 
 

 Set the Drivetime to 20 minutes and check the Draw 
drivetime zone behind roads box 

 
 Click OK  

 
You can now find out how many People on the FastStats system live 
within this 20 minute drive time by: 
 

 Right click within the selected area and drag onto the 
workspace 

 

 Click on the  Build button of the selection window that has 
been created 

 
The result will be all the records shown on the map which can be 
reached within a 20 minute drive from the centre of Warwick. 
 

  
 

 
                         Create Drivetime Zone Window 

 
 
 

 
                         Drivetime Zone Display 
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Multiple Layered Maps 
 
It is possible to create Maps with multiple layers.  These layers can be 
either shaded or plot maps using different selections.  To show the two 
maps created earlier on the same map page: 
 

 Redisplay the shaded Map of Managers with US Bookings 
 

 Click the  button to apply a second set of settings 
to your Map 

 
To replicate the High Earners in Coventry PA display on top of the 
shaded map of Managers with US Bookings: 
 

 Drag the selection High Earners in Coventry PA onto the 
Return all People filter box 

 
This has to be applied in this way because the underlying selection 
window still holds the Manager with US Bookings query used on the 
shaded map. 
 

 Apply all the other settings as previously 
 

 Click on the  Build button to see the results  
 
The result is a display that now shows a shaded map of Managers with 
US Bookings, with pushpins indicating which of them have been 
identified as High Earners in Coventry PA. 
 
 

N.B. – To see both full sets of data displayed on the map, leave the 
underlying selection blank and drag Managers with US Bookings onto 
the filter box of the relevant layer. 

  

 
                     Settings to Show Layered Map 

 

 
                         Layered Map Display 
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Searching the Map 
 
Identifying particular regions and specific locations on a map can be 
done in a number of ways. 
 
By default we zoom to the level dictated by the selection on which our 
map is based.  However we can change our view level by clicking on 
the zoom in or zoom out button on the Navigation bar.  We can also 
zoom in by dragging over the map and clicking within the shape we 
have created.  Alternatively right click on the name of a location on the 
map and select Zoom To. 
 
The Navigation bar also has a Find box where we can specify a 
particular location.  This could be an entire country or and individual 
postcode. 
 
 
 
In the example opposite I have typed Apteco’s postcode into the find 
box.  This results in a window appearing, with different options to allow 
us to refine our search: 
 
Address: Type in the actual address we are looking for 
 
Place/Data: Type in as much detail as possible e.g. Warwick Station 
 
Lat/Long: Type in the Latitude and Longitude information if available 
 
OS Grid: Type in the Ordinance Survey grid reference if available 

  
 

 
              Shaded Map – Zoom Control 

 
 

 
           Find Options 
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Selecting from the Map 
 
The options below can be found on the Drawing toolbar. 
 

 
Scribble 
 

 
Select an area of the map by clicking, holding and dragging the pointer to create a joined up shape 

 
Freeform 
 

 
Click on the map and every subsequent click will join the previous point to the new point, until you have identified the area 

 
Rectangle 
 

 
A click and drag will draw a rectangle in any direction from the point where you clicked 

 
Oval 
 

 
A click and drag will draw an oval in any direction from the point where you clicked 

 
Radius 
 

 
A click and drag will draw a circle radiating from your click point, the tooltip indicates the radius distance 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
In each case above, a selection query can be created from the 
shape drawn.  This can be achieved by a right click drag from 
within the shape onto the workspace.  
 

N.B. – The white boxes on the line show it is active.  If the 
boxes disappear, click on the line again. 
 

 
     Radius Selection 
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Map Wizards 
 
This group of wizards interacts with Microsoft MapPoint to allow you to 
identify records in relationship to time and distance, using geographical 
variables.  The result of these wizards will create a Virtual Variable, 
which will appear in the System Explorer. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

  
 

 
                                                                 

 

 
  Wizards Ribbon Bar – Map Wizards Section 
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Drive Zone Wizard 
 
The Drive Zone wizard provides a quick way to group records by their 
distance (or drive time) from a specific point.  When grouping records 
by distance, the distance “as the crow flies” is used. 
 
Example 
 
Create a Selector virtual variable of 30 minute Drive Zones based from 
the central point of the East Midlands Airport to see where existing 
customers live in terms of drive time from that airport. 
 

 Click on the Drive Zone wizard. 
 

 Step 1 – Determine the settings that will be used in the 
calculation of the drive times or drive distances.  Click Next. 

 
 Step 2 – Enter the centre point that MapPoint can use, this 

could be a postcode or town name.  If you have multiple centre 
points it is possible to drag a file containing them onto the 
appropriate box at this stage.  In this example use East 
Midlands Airport’s postcode DE74 2SA.  Click Next. 

 
 Step 3 – Drag on the geographical variable that will be used to 

plot the points from the centre point – Postal District.  Click 
Next. 

 
 Step 4 – Determine if you are going to create a variable based 

upon drive time or distance – Use Drive Time.  Click Next. 
 
 
 
 
 
 
 

  

 
                       Drive Zone Wizard – Step 1 

 

 
                        Drive Zone Wizard – Step 3 
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 Step 5 – Determine the zones to be created.  Half hourly zones 

from the centre point are shown in the screen shot opposite.  
Click Next. 

 
 Step 6 – Add Optional Notes.  Click Next. 

 
 Step 7 – Type the description name for the variable – Airport 

Drive Zones.  Click Next. 
 

 Step 8 – This step is only visible if you are running an 
Enterprise system and you have ticked the Modify Security 
Attributes box in the previous step.  It allows you to select 
security options for yourself, groups you belong to or anyone 
else. 

 
 Step 9 – This step will tell you how many records have been 

updated.  Tick the Show new variable as a selection box.  
Click Finish. 

 
 
The variable is now available for you to select individual or consecutive 
30 minute drive zones to find households within Postcode Districts 
from the East Midlands Airport. 
 
The Unclassified category in this example will be all Households in 
Postal Districts over 120 minutes from the East Midlands Airport. 
 
 
Suggested Uses 
 

 Identify customers/prospects within a certain distance from a 
retail outlet. 

 
 
 

 

 
                         Drive Zone Wizard – Step 5 

 

 
                         Drive Zone Virtual Variable 
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Location Geocoder 
 
The Location Geocoder wizard gives us the opportunity to create 
Latitude and Longitude Virtual Variables.  For a given group it will 
calculate the Latitude and Longitude for each distinct value for a 
geographical variable within the selection. 
 
Example 
 
Create the Latitude and Longitude variables to allow you to find the 
households, by Postcode for a selection of High Earners. 
 

 Click on the Location Geocoder wizard. 
 

 Step 1 – Drag on a selection of People with an Income of 
£100+.  Click Next. 

 
 Step 2 – Set the World Region to Europe.  Click Next. 

 
 Step 3 – Enter your geographic variable (Postcode) which can 

be a place or part of a postcode that can be evaluated to a 
single point.  Click Next. 

 
Tick the box Geographical variable is either part or whole of 
a zip code/postcode.  Click Next. 
 

 Step 4 – Select or create a folder where you want to place your 
Virtual Variable.  Leave the default for the Others folder.  Click 
Next. 

 
 Step 5 – Enter optional notes.  Click Next. 

 
 Step 6 - Type the description name for the Latitude variable – 

High Income Latitude.  Click Next. 
 
 

  

 
                         Location Geocoder Wizard – Step 1 
 
 

 
                         Location Geocoder Wizard – Step 3 
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 Step 7 – There is currently no Step 7 

 
 Step 8 - Type the description name for the Longitude variable – 

High Income Longitude.  Click Next. 
 

 Step 9 - This step is only visible if you are running an 
Enterprise system and you have ticked the Modify Security 
Attributes box in the previous step(s).  It allows you to select 
security options for yourself, groups you belong to or anyone 
else. 

 
 Step 10 - This step will tell you how many records have been 

updated.  Tick the Show new variable as a selection box.  
Click Finish. 

 
 
Suggested Uses 
 

 Identify locations using latitude and longitude information 

 
 

 
                         Location Geocoder Wizard – Step 6 
 

 

 
                         Location Geocoder Wizard – Step 8 
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Point to Point Wizard 
 
The Point to Point Wizard provides a way to record the drive time or 
distance between a selection of records and a specified centre point as 
a virtual variable. 
 
Example 
 
Create a Numeric virtual variable to find the number of households, by 
distance from Warwick to the Postal Areas within the region of West 
Midlands. 
 

 Click on the Point to Point wizard. 
 

 Step 1 – Drag on a Selection to find Households in the West 
Midlands Region.  Click Next. 

 
 Step 2 – Select the settings to reflect your location and road 

speeds.  Click Next. 
 

 Step 3 – Enter your centre point (Warwick) which can be a 
place or part of a postcode that can be evaluated to a single 
point.  You also have the opportunity to drag on a file if you 
have multiple centre points.  Click Next. 

 
You may find at this point a pop up window appears to confirm 
the entry you made.  Select the correct location. 
 

 Step 4 – Drag on the geographical variable (Postal Area) so 
that a calculation can be made between the centre point 
(Warwick) and the centre points of each geographical area as 
limited by the selection in Step 1. 

 
Tick the box Geographical variable is either part or whole of 
a zip code/postcode.  Click Next. 

 

  
 

 
                         Point to Point Wizard – Step 3 

 

 
                        Point to Point Wizard – Step 4 
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 Step 5 – This step allows you to decide if the variable created 

will be based upon drive time or distance.  Select the Use 
Drive Time radio button.  Click Next. 

 
 Step 6 - Select or create a folder where you want to place your 

Virtual Variable.  Leave the default for the Others folder.  Click 
Next. 

 
 Step 7 - Enter optional notes.  Click Next. 

 
 Step 8 - Type the description name for the variable – West 

Midlands Point to Point.  Click Next. 
 

 Step 9 - This step is only visible if you are running an 
Enterprise system and you have ticked the Modify Security 
Attributes box in the previous step.  It allows you to select 
security options for yourself, groups you belong to or anyone 
else. 

 
 Step 10 - This step will tell you how many records have been 

updated.  Tick the Show new variable as a selection box.  
Click Finish. 

 
You can now make distance selections in the numeric variable by 
typing in the free form box.  E.g.  <20 will return all households within a 
Postal Area, less than 20 miles from its central point from Warwick. 
 
Suggested Uses 
 

 Identify distance/time between retail outlet and customers. 
 

 Calculate average time travelled by customer segments – drop 
the variable onto a cube and use the average function to see 
breakdown of customer groups. 

 

 

 
                       Point to Point Wizard – Step 5 

 

 
                       Point to Point Wizard – Step 8 

 



 
FastStats Discoverer – FastStats Geo                          User Document 

FastStatsTM                   Apteco Ltd © 2000 – 2015             26 

                   

 

Territories Wizard 
 
The Territories Wizard allows you to create a Virtual Variable based 
upon geographical territories that you can define within MapPoint.  You 
will then be able to identify the number of records in each territory. 
 
 
Example 
 
Create a Selector virtual variable to find the number of households, in 
the regions of England Scotland and Wales as defined on a MapPoint 
map. 
 
First you will need to define the territories on the map: 
 

 Drag the MapPoint tool onto the workspace and click on the 

 Territories button. 
 

 From the Method window select the Create manually radio 
button.  Click Next. 

 
 From the Geography window highlight Postcode District.  

Click Next. 
 

 The final window gives you some tips on selecting your 
territories on the map.  Click Finish. 

 
 Name your first New Territory as England and start to make 

your selections.  Continue until you have 3 territories, England, 
Scotland and Wales. 

 
 Save the MapPoint as UK Country Regions. 

 
 
 

  

 
                                     MapPoint Create Territories Wizard - Geography 

 
 

 
                  Territories Selected on a Map 
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The next stage is to use the Territories Wizard to create a Virtual 
Variable from the definitions you just made in MapPoint.  As you 
already have the MapPoint window open that you want to use, you can 
click on the Territories Wizard icon at the top of the window. 
 

 Click on the  Territories Wizard button. 
 

 Step 1 – Select the Update a territory variable from the map 
radio button.  Click Next. (You will go to Step 4) 

 
 Steps 2 – This step asks for the Map you wish to work with.  

Click Next. 
 

 Step 3 – This step is looking for the variable which needs to be 
updated to the Map if you chose the other option at Step 1.  
Click Next.  (You will go to Step 11) 

 
 Step 4 – You can enter the Geographical variable (Postal 

District) from which your Territory will be built.  Click Next. 
 

 Step 5 – Follow the Export to Excel instructions.  Click Next. 
 

 Step 6 – Follow the copy instructions.  Click Next. 
 

 Step 7 – Click on the Click here to populate the grid from 
your clipboard.  Click Next. 

 
 Step 8 – Add optional notes.  Click Next. 

 
 Step 9 – Enter the description UK Country Territories. Click 

Next. 
 

 Step 10 - This step is only visible if you are running an 
Enterprise system and you have ticked the Modify Security 
Attributes box in the previous step. 

 

 

 
                        Territories Wizard – Step 1 

 

 
                         Territories Wizard – Step 6 
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 Step 11 – Tick the Show new variable as a selection box.  

Click Finish. 
 
The Variable that has now been created presents you with categories 
based upon the selections you made on the map.  Each of these 
categories now contains the number of relevant Households on the 
FastStats database. 
 

 N.B. Your results will only be as accurate as your Map selection! 
 
To display this variable (or any other appropriate variable) in MapPoint: 
 

 Click on the Territories Wizard. 
 

 Step 1 – Select the Apply your territory variable to the map 
radio button.  Click Next. 

 
 Steps 2 – Drag on a blank Map.  Click Next. 

 
 Step 3 – Drag on the variable to display/update UK Country 

Territories.  Click Next. 
 

 Step 11 – Click on Finish to display the Map. 
 
By following the steps earlier it is now possible to update the display 
and overwrite the virtual variable. 
 
 
Suggested Uses 
 

 Create sales regions – identify areas using geographical 
variables on a map 

 

 

 
                        Territories Virtual Variable 

 

 
                        Territories Wizard – Step 3 
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Bing Maps 
 

Shaded Map 
 
A shaded map allows us to display records using particular 
geographical boundaries e.g. by Postal Area, Postal District or Postal 
Sector in the UK.  This gives us the opportunity to look at the 
distribution of our customers or prospects around the country. 
 
In the following example we will display a selection of people, who are 
managers that have made bookings to the US and display them on a 
shaded map by Postal Area. 
 

 Create a selection query that identifies Managers who have 
booked holidays to the United States 

 

 Drag and drop the  Map tool on top of the selection window 
 
The Map page has two tabs; the one entitled Map currently shows the 
default display region and will be where the final display will be shown.  
The second tab, entitled Layer 1 is where we define how the results 
will be displayed.  Multiple layers can be added to your map, which will 
be covered further on in this document. 
 

 Click on the Layer 1 tab 
 
An explanation of the options on this window is shown on the next 
page. For now we will just make the changes shown in the screen shot 
opposite i.e. drag on Postal Area as the Geographical Variable and 
change the layer title. 
 

 Click the Build button 
 

N.B. – At any time you can change the underlying map provider by 
clicking on the Provider drop down menu e.g. use Open Street Map. 

  

 
                         The Map Tool – Map Tab 
 
 

 
                      Layer Tab – Shaded Map 
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Shaded Map - The Layer Tab 
 
The options on the Layer tab are the same as those if we were using 
MapPoint.  See pg. 6. 
 
 

Shaded Map – Viewing the Map 
 
Now that the results have been calculated and displayed, we can see 
the Map area has zoomed in on the UK.  Each Postal Area that 
contains records from our selection has been colour shaded.  The 
colour shading has defaulted to 8 Equal Data Points.  Options for this 
layer can be set in the Layers panel. 
 
Visibility: Make the layer display visible or hidden on the map 
Scheme: Select a colour scheme to be applied to the shading 
Type: Select the appropriate display type and ranges 

 
 
At the bottom left of the map window is a display of the Latitude and 
Longitude coordinates.  The display changes to reflect the movement 
of the mouse pointer. 
 
At the bottom right of the map window is the map scale. 
 
At the bottom centre of the map window is a view control cluster. 
 

 The arrows will push the map in the direction of the arrow 
clicked 

 The eye symbol gives access to the different map views 

 The magnifying glass symbol gives access to the pre-set zoom 
levels 

 The centre button makes the cluster visible or hidden 
 
 

  
 
 
 
 
 

 
                                        Bing Map – Layers Panel 
 
 
 
 
 
 

 
            Bing Map – Bottom of Map Window 
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 Click on the  Zoom button 
 
There are 5 pre-set zoom levels, from a World view right down to a 
local Neighbourhood. 
 
Clicking on the arrow buttons will push the map display in the direction 
of the arrow clicked. 
 
Alternatively click on the Drag option at the top of the window: 
 

 Click and hold the left mouse button. The map will move in the 
direction you now move your pointer 

 
 Click on the small arrow in the top right of the window to reveal 

an insert map on a larger scale.  Use the same method to 
move around within that map 
 

 
 
The Eye symbol will give access to a series of views: 
 
 
Road View: 
 

 
A road map image will be displayed 

 
Aerial View: 
 

 
A photographic aerial image will be displayed 

 
Bird’s Eye View: 
 

 
A photographic angled image will be displayed 
when using a close zoom e.g. Neighbourhood 

 
Show Labels: 
 

 
Applies road names etc. on a photographic 
display 

 

 
 

 
                       Bing Map – Zoom Options 

 
 

 
                                Bing Map – Bird’s Eye View with Labels 

Apteco Office 
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Shaded Map – Viewing the Results 
 
The map opposite has zoomed in over the Midlands region of the UK. 
 
The results of our underlying selection have been applied through the 
colour shading.  The legend, depending on the settings used may have 
a wide range of results associated with a particular colour. 
 
To find the actual result move the mouse pointer over the Postal Area 
of interest, which will be highlighted and the tooltip will display the 
count. 
 
To select results from our map we can use tools from the Drawing Tool 
bar at the top of the window.  In this example we will use the scribble 
tool to find an area of interest. 
 

 Click on the Scribble tool and then click and hold the left 
mouse button to draw a joined up shape 

 
 An item will be entered under the Selections section of the 

Layers panel. Click and drag the  button onto the workspace 
to see and count the selection 

 

N.B. – The line drawn on the map crosses several Postal Areas, 
so how does FastStats interpret your shape?  FastStats looks to see if 
your line crosses the border of a geographical variable and if it does it 
will include everyone in that area.  So for a more accurate result a 
more granular variable should be used e.g. Postal Sector. 
 

N.B. – See pg. 41 for more details on the various selection tools. 

  
 

 
                           Shaded Map – Tooltip Count Display 

 

 
                          Shaded Map – Scribble Tool Selection 
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Shaded Map – Using a Segment Variable 
 
When using the shaded map option it is possible to display segmented 
data from a selector variable or selection query.  For example we may 
wish to display graphically the occupations of our customers by the 
Postal Area in which they live. 
 

 Using a blank selection drag on a Map tool and change the 
Layer 1 tab to reflect the options in the screen shot opposite 

 

 Click the Build button 
 

The default display uses a sized pie chart to show the categories of the 
variable.  The legend indicates the colour coding used to identify each 
of the segments. 
 
We can change the chart used by going to the Layers panel on the left 
of the screen, and making a selection from the Type drop down menu. 
 

N.B. – Moving the mouse pointer over a chart on the map will 
display the details in a tooltip. 
 
 

  

 
                        Layer Tab – Occupation as the Optional Segment Variable 

 
 

 
                Bing Map – Display of a Segment Variable Results 
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Shaded Map – Adding Statistics 
 
As well as displaying values e.g. the number of People on a map, you 
can also generate and display a calculated statistic for those people 
being represented on the map. 
 
Let’s use the example of Occupations by Postal Areas which we used 
in the previous example.  We can now amend this example to 
optionally display the total profit each of those occupations (in the 
specific Postal Area) has contributed to our business. 
 

 Click on the Layer tab (Entitled Occupations by Postal Areas) 
 

 Click on the Add Statistics… button to display the Statistics 
window 
 

 Click on the radio button Specify other Table, Variable or 
Expression 
 

 We can now drag on the Profit variable and select the statistic 
we want to apply (in this example Sum) 
 

 Click OK 
 

 Within the Statistics panel change the Primary Statistic from 
People to Sum(Profit) 
 

 Click the Build button 
 
When we move the mouse pointer over a chart, the tool tip that is 
displayed now shows the total profit figure per occupation for the 
Postal Area they live in. 
 
 
 

  

 
                         Statistics Window – Summing the Profit Value for People 

 
 

 
                             Shaded Map View – Sum of Profit Statistic Display 
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Plot Map 
 
A plot map allows us to display records using a more precise 
geographical boundary e.g. by UK Postcode.  This gives us the 
opportunity to look at the location of smaller groups of customers or 
prospects around the country. 
 
In the following example we will display a selection of people, who live 
in the Coventry Postal Area and earn £70-80K or more. 
 

 Create a selection query that identifies the high earners in the 
Coventry Postal Area 

 

 Drag and drop the  Map tool on top of the selection window 
 

 Click on the Layer 1 tab 
 

 Complete the window as shown opposite 
 
An explanation of the options on this window for a Plot Map can be 
found on pg.12.  
 

 Click the Build button 
 

  
 
 

 
    Layer Tab – Plot Map 
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Plot Map – Viewing the Map 
 
To get a closer or different view of the Map: 
 
At the bottom centre of the map window is a view control cluster. 
 

 The arrows will push the map in the direction of the arrow 
clicked 

 The eye symbol gives access to the different map views 

 The magnifying glass symbol gives access to the pre-set zoom 
levels 

 The centre button makes the cluster visible or hidden 
 
The screen shot opposite shows the map centred over Coventry.  
 

N.B. – Large pins are displayed on the map to represent multiple 
sites if the map is at a less granular view e.g. State or Region. 
 
 

Plot Map – Viewing the Results 
 
To select results from our map we can use tools from the Drawing Tool 
bar at the top of the window.  In this example we will use the scribble 
tool to find an area of interest. 
 

 Click on the Scribble tool and then click and hold the left 
mouse button to draw a joined up shape 

 
 An item will be entered under the Selections section of the 

Layers panel. Click and drag the  button onto the workspace 
to see and count the selection 

 
 
 
 

  

 
            Plot Map – High Earners in Coventry Postal Area 
 

 
                                  Plot Map – Scribble Tool Selection 
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The selection we have just made on the map can be renamed for 
easier reference.  To temporarily hide the selection from the map, we 
can change the visibility option from Visible to Hidden. 
 
To remove the selection permanently from the map we can click on the 
Delete button on the relevant selection row, under the selections 
heading. 
 
 

N.B. – See pg. 41 for more details on the various selection tools. 
 
 
 
 
 
 
 
 
When we were setting the options on the Layer tab we added 3 
variables to the Additional Variables panel.  This will allow us to view 
this information for the records shown on the map. 
 

 Right click on a pin on the map 
 

 Select Show Information from the pop up menu 
 

If the pin represents a single record, a balloon will appear with the 
URN and the relevant variable information for that record. 
 
If the pin represents more than one record, a window will appear listing 
the postcode for each of those records. 
 

 
                                                           Layers Panel 
 
 

 
                   Plot Map – Show Information 
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Plot Map – Create Drivetime Zone 
 
It is possible to use this function to find People who live within a 
determined area calculated upon the number of minutes or the 
distance it takes to drive from a given point. 
 

 Using the Plot Map from the last example, create a drive time 
zone of 20 minutes from the centre of Warwick 

 
 Right click on the map and select Search… from the pop up 

menu 
 

 Type Warwick into the Location box and click OK 
 

If necessary we can be more specific with our starting point by using a 
Postcode. 
 

 Right click on the pin representing the location 
 

 Select Create DriveTime… 
 

 Set the DriveTime to 20 minutes 
 

 Click OK  
 
You can now find out how many People on the FastStats system live 
within this 20 minute drive time by: 
 

 An item will be entered under the Selections section of the 

Layers panel. Click and drag the  button onto the workspace 
to see and count the selection 

 
The result will be all the records shown on the map which can be 
reached within a 20 minute drive from the centre of Warwick. 
 

  
 

 
                         DriveTime Settings Window 

 
 
 

 
             Drivetime Zone Display 
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Multiple Layered Maps 
 
It is possible to create Maps with multiple layers.  These layers can be 
either shaded or plot maps using different selections.  To show the two 
maps created earlier on the same map page: 
 

 Redisplay the shaded Map of Managers with US Bookings 
 

 Click the  button to apply a second set of settings 
to your Map 

 
To replicate the High Earners in Coventry PA display on top of the 
shaded map of Managers with US Bookings: 
 

 Drag the selection High Earners in Coventry PA onto the 
Return all People filter box 

 
This has to be applied in this way because the underlying selection 
window still holds the Manager with US Bookings query used on the 
shaded map. 
 

 Apply all the other settings as previously 
 

 Click on the  Build button to see the results  
 
The result is a display that now shows a shaded map of Managers with 
US Bookings, with pushpins indicating which of them have been 
identified as High Earners in Coventry PA.  To see both full sets of 
data displayed on the map, leave the underlying selection blank and 
drag Managers with US Bookings onto the filter box of the relevant 
layer. 
 

N.B. – To select from a particular layer, ensure all other layers are 
set to Hidden. See pg. 41 for more details on the various selection 
tools. 

  

 
                     Settings to Show Layered Map 

 

 
             Layered Map Display 
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Searching the Map 
 
Identifying particular regions and specific locations on a map can be 
done in a number of ways. 
 
Region Search 
 
A list of countries is available from the Region drop down menu, 
located on the toolbar at the top of the map.  Upon selecting a 
particular country the map will zoom to the State level view. 
 
 
Cluster Tool Search 
 
We used this tool on pg. 30/31 to allow us to zoom into the map in 
stages – World, State, Region, City & Neighbourhood. (Region in this 
context refers to an area within a State) 
 
 
Location Search 
 
For a more specific search we can use the Search… facility from the 
right click menu.  The location box will allow us to enter the name of a 
Town, City or even a Postcode.  The location will be displayed with a 
pin symbol. 
 
 
Layer Panel 
 
In this panel the visibility of any selection can be changed temporarily 
from Visible to Hidden. 
 
To remove a search permanently from the map click the Delete button 
next to the relevant search. 

  

 
                       Bing Map – Region Germany 
 

 
               Location Search – Using Apteco’s Postcode 
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Selecting from the Map 
 

 
Adhoc 
 

 
Select or deselect by clicking on individual regions on the map e.g. records displayed by Postal Area 

 
Scribble 
 

 
Select an area of the map by clicking, holding and dragging the pointer over the desired area 

 
Polygon 
 

 
Click on the map and every subsequent click will join the previous point to the new point, until you have identified the area 

 
Rectangle 
 

 
A click and drag will draw a rectangle in any direction from the point where you clicked 

 
Oval 
 

 
A click and drag will draw an oval in any direction from the point where you clicked 

 
Radius 
 

 
A click and drag will draw a circle radiating from your click point, the tooltip indicates the radius distance 

 

 
                               Adhoc Selection                                                                      Polygon Selection                                                                 Radius Selection 
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Appendix 1 – Further Information 
 

FastStats Geo Module 
 
This licence comes with the OpenStreetMap free service.  To use 
FastStats with Microsoft MapPoint you will need to purchase a 
licensed copy of this software and have it installed on the machine with 
which you are accessing your FastStats system.  To use Microsoft 
Bing Maps, the online mapping service, you will need a Bing key, 
which can be obtained through Apteco. 

 
 
Boundary Files 
 
To apply data to your online maps you will require boundary files, also 
known as shape files.  Apteco can provide basic UK shapes; Postal 
Area, Postal District and Postal Sector. 
 
Various boundary files are available and some nations e.g. Australia 
make these available free of charge. 
 
A broader range of boundary files, can be purchased from commercial 
organisations such as MapMechanics – www.allmapdata.com 
 
Other commercial providers are available. 
 

  
 

Microsoft MapPoint 
 
As this software is loaded on to your machine you have some restrictions in 
terms of mapping displays i.e. Europe and North America.  Also MapPoint is 
a ‘closed box’ application; therefore you are restricted to the data used in 
that version of the software. 
 
www.microsoft.com 

 
 
Bing Maps 
 
A Bing key gives you access to the geocoding functionality of the software 
and gives you a potential worldwide display, with the appropriate 
boundaries.  Bing maps gives you access to the majority of MapPoint 
functions except for the Mapping Wizards. 
 
www.bing.com 

 
 
OpenStreetMap 
 
As OpenStreetMap is a free service and without the addition of Bing Maps, 
will only allow you to display thematically shaded maps, with the appropriate 
boundary files being available.  With a Bing Maps key, OpenStreetMap can 
display the geocoding functions on its map display. 
 
www.openstreetmap.org 
 

 


